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Writing a letter, article, book, or invitation, or sending an email or a text message? 
The Keyboard Help site offers help on typing accented letters and other non-standard characters/symbols, 
in a variety of programs and on a variety of devices (phone/tablet, laptop, Windows, Mac, Android).





HostingAdvice Blog has an article about Keyboard Help (2/6/20) and more.


Endangered Language Alliance 

Article on Translation of NY Times into Spanish, a Diverse Language (7/4/19)

NY Times Opinion Article, Why It’s So Hard to Learn French in Middle Age (4/30/19)

NY Times Obit, Zhou Youguang, 
Who Made Writing Chinese as Simple as ABC, Dies at 111 (1/14/17)

Hats Off to the Circumflex, a NY Times op-ed article (2/19/16) 

Foreign Language Fluency needed, a CNN Money online article (10/30/13)







	
               Please visit our Friends

              
	Sprachreisen nach England
	Sprachreisen
	Learn English in Malta
	Spanish in Malaga Spain 
	Errata in published books


            
(NOTE: only the authors' links will be added here as of Feb 1, 2016)





This page in Portuguese 
and Macedonian, except recent additions. Thanks to the translators.





        [bookmark: win]Windows, Using Roman Alphabets 

          
          (Note that the various versions of Windows vary in details and vocabulary
            but have somewhat similar methods.)

Because individual applications such as word processors or
HTML codes have their own schemes (Word,, HTML)
they are less likely to be 100% transferable to other software applications.
However, most Windows applications,
including word processors, will accept these methods: 


	Change/add Keyboard
	International English Keyboard (the easiest for a combination of many Western European accent marks) 
	Alt Key Codes
	Character Map or PopChar
	Other European, Right-Left, and Asian Keyboards



            
        
	 [bookmark: change]Change or add Keyboards


This site 
has info for Win 10. The first steps: click the windows icon at bottom left,then Settings, Time and Language, 
 Preferred languages. After you have multiple keyboards, to switch between them, press the Windows key + Space or click the 
 Language indicator on the task bar near the time/date on the lower right.




 Keyboard
layouts for many languages are available. However, they usually do not
follow the "QWERTY" layout and some characters, especially punctuation,
will not correspond to those printed on your keys. French uses "AZERTY"
with letters a/q and z/w interchanged compared to the US keyboard.
           




[image: ]for layout 
              charts for several languages. 

              Once the language keyboards 
              are installed, using alt+shift or a designated variation rotates through 
              them (adjustable by changes after pressing the "Key Settings" button. Click the taskbar language icon to switch 
              to another language. [bookmark: intl]
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	The US-International English keyboard layout 
            is installed as above  and has these features:

	It uses the following intuitive methods which work with most (or 
              all) Windows applications, while keeping the familiar QWERTY 
              keyboard.             
	Press one of the five modifier keys `  '  "  ~  
              ^ , then the letter to be modified.
            ( ' then a = á,   " then u = ü, ' then c = ç, 
            etc. )
             
	Press the right alt key  + another key. Examples:

              right alt + ,  = ç  (or  ' + c)  

                                  + / = ¿  

                                  + 1 = ¡  

                                  
                      + c = ©  
                      
  + 5 = Euro currency symbol      
[image: ]
for a complete chart and printer-friendly summary.
                      


              
            	Note that this maintains the "qwerty" layout. However, the modifier 
              keys `  '  "  ~  ^  must sometimes be followed by 
              pressing the space bar when they are actually intended. The system 
              can accept words requiring an apostrophe, such as it's, 
              without the space bar.   


            	 If you are having punctuation key troubles 
              such as your computer's quote and apostrophe key behaving strangely, 
              the cause may be that your keyboard was accidentally set to the 
              International English Keyboard. The solution is to reset it to a 
              standard English or United States keyboard. [bookmark: easteuro]


          
      
  [bookmark: alt]

      	Alt Key Codes (also called Alt number or altnum)

          

	Those who use only a few characters, but often and in many applications,
may prefer to keep the default United States English keyboard and memorize
a few Alt key codes. This method uses the Alt key plus a four digit
number entered via the numeric keypad, with Num Lock on. The modified
letter appears after the keys are pressed and released. For touch-typers, the
disadvantage is having to move their hands to the number pad on the
right of the keyboard. Examples follow. Anecdotal evidence suggests that this
works in most programs, even in email and filenames. 
Note that some laptops have a "hidden" numeric keypad. 



      

      
	ALT + 0224 =
à        ALT + 0225 = á
	ALT + 0232 =
è        ALT + 0233
= é         ALT + 0200 =
È
	ALT + 0242 =
ò        ALT + 0243 =
ó         ALT + 0241 =
ñ      
[image: ]
for complete lists (including Esperanto). [bookmark: map]

 
         	 Character Map

        
        	This is useful for the infrequent accent or symbol. 
Use the search box near the lower left to reach it.
 
After
choosing a font, double click the desired character(s). After clicking
Copy, return to your document and paste. Some fonts (such as Symbol,
Webding, and Wingding) provide Greek, icons, arrows and symbols. This
system may fail if a  combination of keystrokes, as seen in
the lower right of the window, has been reserved for another application.


	


        	PopChar
is an improvement over the Character Map. When you need a special
character, click the "P" box in the taskbar to display a table of
characters. Select the desired character and it instantly appears in
your document. HTML symbols are also available.

        [bookmark: word]
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MS Word uses an extremely intuitive approach giving it advantages similar to 

(but perhaps less universal than) the International English Keyboard. 

Note that sometimes the software adds its own accent marks (as in café), perhaps as part of spell checking.
      

1. Press CTRL and one of the punctuation keys ` ' , ~ : ^
that most closely resembles the accent needed.  

2. Release the two keys pressed in Step 1. 

3. Press the letter to be modified and the accented character will appear.  
        

          Thus Ctrl+: with u gives ü and Ctrl+, with C gives Ç.  
        
        The following chart came from MS Word help/index/characters/inserting/type international. Newer versions have slightly different wording such as help/index/character, then click on Insert an 
international character by using a shortcut key. Note that some keys such as & require a shift key also. 

            
		à, è, ì, ò, ù - À,
              
              È,
              
              Ì, Ò, Ù	CTRL+` (ACCENT GRAVE), the letter 
                or the LETTER

	á, é, í, ó, ú, ý -
              
              Á,
              
              É, Í, Ó, Ú, Ý	CTRL+' (APOSTROPHE), the letter
	â, ê, î, ô, û Â, Ê,
              
              Î,
              
              Ô, Û 	CTRL+^ (CARET), the letter
	ã, ñ, õ Ã, Ñ,
              
              Õ 	CTRL+~ (TILDE), the letter
	ä, ë, ï, ö, ü, ÿ Ä,
              
              Ë, Ï,
              
              Ö, Ü, Ÿ 	CTRL+: (COLON), the letter
	å, Å 	CTRL+@, a or A
	æ, Æ 	CTRL+&, a or A
	œ, Œ 	CTRL+&, o or O
	ç, Ç 	CTRL+, (COMMA), c or C
	ð, Ð 	CTRL+' (APOSTROPHE), d or D
	ø, Ø 	CTRL+/, o or O
	¿	ALT+CTRL+?
	¡ 	ALT+CTRL+!
	ß 	CTRL+&, s[bookmark: math]

        
	Math and other Symbols 

        Word 2010
has excellent features which one can reach by choosing the Insert Tab
and then going to the symbols section of the "ribbon". Clicking on
"Equation" provides about ten built-in equations including the area of
a circle and the quadratic equation. Clicking on the Π
above "Equation" opens a ribbon of math terms similar to those in the
2003/2007 math equation editor. The drop-down arrows lead to many more
terms. Clicking on "Symbol" results in a variety of those, many of
which can be pasted into other software.Click  here for a chart of math and music symbols using the alt plus 4 digit codes..



        Some  Word 2010 features are similar to Word 2003/2007 where many non-English characters, as well as some icons are found in
          
          the Insert menu, then select Symbol and More Symbols. Within this Symbol Window, the font Lucida Sans
          
          Unicode
provides many accented and other characters for numerous languages.The
Wingding font has many other characters. The Character
Map (see above) also has these fonts.

 

        Word's Equation Editor is available on the Insert menu in the Symbol section. 
  
  Purchasing a more convenient math editor such as Math
    
    Type is advised for those who write equations often. 

      More Math tips for MS Word:
  
  

*The Symbol font (in the Home tab) also  has many math characters. For example, after changing
  
  to the Symbol font, press the tilde key at upper left, without the
  
  shift key. You should see a bar. Then type another key such as s; the
  
  result for s is a lower case Greek sigma below the bar. If you need an
  
  x or X or other letter under the bar, change the font back to a text
  
  font such as Times Roman, and then type x or X. 

*For superscripts, such
  
  as xn: type x, then press and hold Ctrl,
  
  Shift, =. Then type n. To go back to normal letters, press and hold
  
  Ctrl, Shift, =. Subscripts are similar but omit the Shift key.[bookmark: wpf]



Word Perfect has spell checking, thesaurus, grammar, and
hyphenation for numerous languages. Another feature is
creating a custom keyboard. However, the remapped keyboard may only work within the WordPerfect application. 



[bookmark: html]The Web and HTML tags: If writing directly in HTML code, the tags for special characters are 
  relatively intuitive. They start with & and end with 
  a semi-colon . Examples are &euro; for €, &ouml; for ö, &Ouml; for Ö, &ntilde; for ñ,  
&egrave; for è, &eacute; for é, &lt; for < 
(less than), &gt; for > (greater than), &amp; for &,  &nbsp; 
for non-breaking space, and &copy; for 
  ©.ASCII numerical codes (such as &#128; for the Euro) are also available on the 
  chart.  [image: ] for complete lists.
  In a software application such as Dreamweaver,
  
  one can use the International English keyboard.
  
  Also, Dreamweaver has Insert - special characters in the menu
  
  bar. The shareware application NoteTab  provides another method as well as other useful features. [bookmark: non]
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Non-Roman Alphabets


The following have been mentioned on LLTI or other correspondence; I do not have personal experience with them. 


  		Asian Languages 

	 Chinese Language: Information Page
	 Wenlin Dictionary
	 Chinese Characters and Culture
	 Marjorie Chan's China Links
	 Chinese Computing Help Desk
	 free tool for English to Chinese translation


            	 Los Angeles Chinese Learning Center: non-profit cultural exchanges and lessons.

              
	Read/Type Chinese  on a 
                Computer.
	 Read/Type Japanese on Your Computer
	 Thai font info 
	 WinVNKey a Vietnamese Multilingual Keyboard Driver (Windows)
            

            		Cyrillic 

	 Paul Gorodyansky:



	Other 

	African languages by Don Osborn (extended Latin character use)
	Yiddish Software
	John Hill (annotated translations of early Chinese texts on the Silk Routes)
 
Click here for his book which is based on 30 years of research. 




 
  

  [bookmark: share]Shareware 

  	 
      DIACRIT Shareware - the language dependent, diacritical character key map for Windows by Paul Herber.

    
	 
      NoteTab - 
        Notepad improvement and a handy HTML editor. The clipbook library and the pasteboard are
        incredible time savers whether you create web pages, write source code, send
        e-mail, take notes, analyze text, read files, or do anything related to text.
        Price varies with the version and features. 

    
	
      PopChar Win 
        - displays a table of characters and HTML symbols which are easily
        moved into documents.

    


  

  Language and Other Services

    		Linux - Accented Characters.
	Wikipedia - site 
            on diacritics

          		Language Schools and 
            Language Courses
	Freeware Reviews
	Free English Language Help 
[bookmark: mac] 
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 Attention webmasters! Please LINK to this page. 
To copy all or some of it, in printed or web page format, please contact me for permission.  	TOP





  
    
 
    










